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1.0 Introduction 
 
 
TSL makes a range of UMDs, all of which are compatible with TallyMan. 
 
All 17mm displays are tri-colour (green, red and amber) for both the display blocks and the 
tally blocks.  The triple and quad displays are only available with green display blocks and 
twin, non separately addressable red tallies. 
 
Each UMD will have a unique address assigned to it by the TallyMan program and this 
address must be manually transferred to the actual hardware by pressing the recessed 
buttons to gain access to the set up menu in the UMD. 
 
Many of the menu items, such as those setting the colour, will be found in the 17mm displays 
via the front panel recessed buttons also in the TallyMan program. 
 
It will be seen that the User screen may be used to build the monitor stack or wall.  If the 
program is on-line it will be seen that the desktop view is interactive and will show the 
mnemonic and tally state of all the UMDs in the system. 
 
UMDs may be associated with routers to show the desired mnemonic and sophisticated tally 
control may be set to the UMDs. 
 
Mnemonics and Names may be copied and pasted into other TallyMan lists or programs such 
as Microsoft Excel for easy editing. 
 
For each UMD the configuring engineer may or may not allow user access by suitably 
checking the Allow user configuration box. 
 

• A UMD driver may address up to a maximum of 126 addresses.  More addresses will 
require that another UMD Driver, with its own Port will be required. 

 
 
Important 
 
When building the monitor stack it is essential that the correct UMD type is entered as the 
build progresses.  It is possible to alter UMD types later but it will be come very confusing 
where this is done on a large system. 
 
For example, if a Single Display is changed to a Triple, some following Displays will be 
subsumed into the Triple Display.  
 
For example, consider the following: 
 
A monitor stack consists of the following Displays; a D8C, D16C, D8C, and D8C.  If the first 
D8C Display is changed to a Triple Display, the following D16C and D8C (Display numbers 2 
and 3) will turn into the Triple Display.  The Mnemonics that were for the D16C (Display 
number 2) are still at Display number 2 but this is now the second 8 character display of the 
Triple Display. 
 
The actual hardware of the original second Display is still a D16C.  This is now at program 
address 002.   Before the changes it was at address 001.  
 
If changes are done in the middle of a large number of mixed display types, extensive 
re-addressing of the Monitor Stack will be necessary. 
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Display Assignment Terminology 
 
This is a key feature of the UMD system: 
 
♦ Fixed Mnemonic means Displays do not change their messages (mnemonics) when 

matrix (router) changes are made.  The have no association with a matrix for their 
mnemonics. 

 
♦ Follow Matrix Destination means Displays are assigned to a router destination / bus 

(output) and they will show the selected router source mnemonic.   
 
♦ Follow Matrix Source means Displays are assigned to a router source (input) and they 

will show the router destination / bus mnemonic.  
 
♦ Fixed Matrix Destination means displays are assigned to the router outputs and show 

the dynamic tally states but they do not change their message (mnemonics) on router 
changes.  They will always show the router destination (output) mnemonic.   

 
♦ Fixed Matrix Source means displays are assigned to the router inputs and show the 

dynamic tally states but they do not change their message (mnemonics) on router 
changes.  They will always show the router source (input) mnemonic.   

 
 
 
Note: 
 
At startup, all UMD's are updated. Thereafter, a background update goes through each 
display address, one every 200mS, refreshing the information.  A full set of 126 addresses is 
refreshed after around 26 seconds when there are no other changes occurring.  If any system 
event (e.g. tally change, crosspoint change) results in a change in UMD information, the UMD 
gets an immediate update. 
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2.0 Entering UMDs into TallyMan 
 
To add UMDs to the system, click on the New System Icon and then Add New System 
Component.  A driver will be added to the tree.  The UMD driver name shown here is TSL 
UMD. 
 

 
 
 
 

 
 
 
 
Add as many drivers to the system as there are UMD types in the system. A driver can drive a 
maximum of 126 addresses.   
 
In the Display Interface Properties box select the UMD Type from the drop down list. 
 
Then press Apply. 
 
If there are other drivers, such as a Zandar multiviewer, select the appropriate entry from the 
drop down list. 
 
 
Note about Disable instant updates for Multiviewers 
 
In the normal mode of operation, "Disable instant updates" should not checked, and the 
background refresh rate is 200mS. If any displays need updating as a result of a tally change, 
or a router change, a message is sent immediately to those displays, with no gaps between 

Select the UMD 
driver type from 
the drop-down list 
– UMD Type. 
 
Multiviewer 
displays will 
require their own 
Driver and will 
need to added 
separately.   
Most multiviewer 
types use TSL 
UMD protocol. 
 
Click on 
Add/Delete 
displays in Layout. 
 
Disable UMD 
Colour 
Initialisation  
allows legacy 
UMD's to be used 
without problems 
 

Type in a Name 
for the selected 
Driver.  This name 
will show on the 
system tree. 
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the messages.  If nothing is changing, a background "refresh" message is sent, to one display 
at a time, with the specified gap between messages (in this case, 200mS). With nothing 
changing, this means a complete background refresh every 7.2 Seconds for 36 displays, for 
example. 
 
If "Disable Instant Updates" is checked, all messages from the system to the displays are kept 
(200mS) apart. So if, for example, 5 displays need to be updated after a change in status, the 
last display will be updated 2 seconds later than the event occurred.  This is only used for 
some multiviewers that cannot show instant updates.  Do NOT use for most display types. 
 
 
3.0 Serial Parameters for the Drivers 
 
Edit the Serial Parameters for the driver in use.  The common drivers will be auto-filled. 
 

 
 
This might be used when a different driver is need for a multiviewer other than taking the data 
feed from one of the standard UMD ports.  Normally, all TSL UMD will be driven directly or via 
a PSU-22 from one of the standard UMD RJ45 ports. 
 
For Multiviewers select UDP if IP connections are available. For UDP connections the number 
of UMD addresses available is 126 per IP/PORT combination. So, any single IP address can 
have as many drivers as necessary 
 
4.0 Adding displays to the layout 
 
 

 
 

A RH mouse click on 
the desktop will 
allow displays to be 
added along with the 
monitor type. 
 
A drop down box 
allows the correct 
type of display (D8C 
/ DD8C etc) to be 
entered into the 
desktop. 
 
It is essential that 
the correct display is 
entered as the 
monitor stack is 
“built” on the 
desktop. 

This shows a TSL 
UMD protocol 
Driver 
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When the display driver has to be changed, for example entering a multiviewer, select 
Change Driver form the list.  The drivers shown will only be those that have been entered 
into the system. 
 

 
 
 
It is crucial that the correct UMD is entered in the program. 
 
Hardware Type  TallyMan 
Type 
D8C/D8  – Single 8 
D16C/D16 – Single 16 
DD8C - Dual 8 
TD8  – Triple 8 
QD8  – Quad 8 
ML1  – ML1 
S8C  – Static 8 
  
 
 
 
Build up the entire monitor stack/wall inserting the correct UMD type and driver as you go. 
 

 
 
 
The box around the stack may be made by clicking and dragging from the top L.H. corner to 
the lower R.H. corner. 
Descriptive text may be added an subsequently edited using a R.H. mouse click and selecting 
Edit Stack. 
 

A frame may be 
made around the 
stack by selecting 
the top LH edge 
and whilst holding 
down the mouse 
button, drag to the 
lower RH corner. 
 
A RH mouse click 
on the stack will 
allow colour and 
Naming changes 
to be made via the 
Edit Stack option. 

Some multiviewers 
use TSL UMD 
protocol.  These are 
entered in the 
program as 
Multiviewer. 
 
This shows a Zandar 
unit that uses its 
proprietary protocol 
– later units use TSL 
UMD protocol. 
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4.1 Tally Out Lamps and Tally Out Relays. 
 
A R.H. mouse click will allow these icons to be added. 
 

 
 
 

 
 
 
These icons provide very simple indication of tally out status and might be useful as an 
indication of which tallies are active at the tail-board of an outside broadcast truck, for 
example.

Select either a 
tally lamp or tally 
relay from the list. 

A Name may be 
set for the relays 
via a R.H. mouse 
click on the icon. 

A Tally Out Lamp 
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A R.H. mouse click and select the item, or a double click on the icon will allow editing and 
access to the assignment dialog box. 
 
 

 
 
 
Edit Assignment will, for example, allow editing of the tallies to the Tally Out pin. 
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Use the View menu to get back to Set up to edit the UMD functions. 
 
A click on the UMD driver will show this dialogue box. 
 

 
 
This shows that three TSL UMDs have been added to the system.  The display type (Single 
8), the Address and the Current Text on the UMD is shown in the list. 
 
A double click on the Display line will show this field. 
 
It will be seen that virtually all dialogue boxes will allow the Configurator to decide on User 
access by checking the box Allow user configuration. 
 
 

  
 
 
 
 
Note:  
 
The Configure Display box allows the basic behaviour of the display to be set with incoming 
tallies.  

Each Display may 
be given a Name  

The Configuring 
engineer may 
Allow user 
configuration. 
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5.0 Setting the Function of a UMD 
 

  
 
 
6.0 Display Text 
 
This box determines how the UMD derives its text.   
 
The UMD may be a: 
 
Fixed Mnemonic display 
Follow Matrix Destination display 
Follow Matrix Source display 
Fixed Matrix Destination display 
Fixed Matrix Source display 
 
6.1 Fixed Mnemonic 
 
The factory default is Fixed Mnemonic with text as Fixed 1.  This may be freely edited in this 
box up to 16 characters – assuming that the UMD can display 16 characters. 
 
6.2 Matrix / Router associated displays 
 
The Matrix Recursion Depth is set here for a UMD assigned to Matrix destinations assuming 
that several routers / matrices are cascaded. 
 

This dialogue 
box will allow 
the display 
assignment to 
be set and the 
tallies to be 
mapped to the 
display.  
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Note 
 
If the UMD is assigned as a Matrix destination display and there are several routers in the 
system there may be a requirement to map the final router’s sources to earlier router’s 
destinations.  Please see the Router Section of this manual.  
 
For example: 
 
There could be, say three cascaded routers in a system. 
 
If source-to-destination mapping is carried out on all three routers, the first router’s source 
mnemonics will show on the third router’s destination UMD.  It might be a requirement that 
this destination display shows only the second router’s source mnemonics and not those of 
the first.  In this example, a figure of 2 would need to be set in the box.  This figure counts 
back from the output. 
 
6.3 Assigning UMDs to a Matrix / Router 
 
 

  
 
 
The Display Assignment box allows the UMD to be associated with a matrix destination or 
source.  
 

This shows the 
UMD has the 
name Cam 1 
UMD and is  
associated with  
the Main Router’s 
Destination 1. 
 
Mnemonic 
information will be 
controlled by the 
router. 

Matrix 
Recursion 
Depth is set 
here.  
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In the Matrix Assignment box, from the dropdown lists for Matrix and Destination or 
Source (as appropriate) select with which Matrix and Destination or Source the UMD is to be 
associated. 
 

• If the UMD is assigned to a destination as a Matrix Destination Display, the selected 
source mnemonics and any matrix associated tally mapping will show on the UMD. 

 
• If the UMD is assigned to a matrix source as a Matrix Source Display, the destination 

mnemonics and matrix associated tally will show on the UMD.  
 
Note: 
 
For UMDs assigned to matrix / router sources be sure to set the Priority for the router 
destinations otherwise destination mnemonics will not be shown on the UMD. 
 
Please see the description of display terminology for operation of Fixed Matrix Source and 
Matrix Destination Displays. 
 
6.4 Matrix Levels 
 
Matrices often have levels, e.g. SDI, Analogue PAL, Time Code etc. so the UMD has to be 
assigned to the desired video level. 
 
Note 
 
Very often it will be seen from the Router section that although there is one main router in the 
system and that it may, for example, have four levels, because of the way the router has been 
entered into TallyMan the UMD level should remain set to Level 1.  This will allow different 
mnemonics to be set for the different levels. 
 
Please see the Router section for more details. 
 
7.0 Direct Tally Assignment 
 
Direct tallies may be assigned to the UMD instead of, or as well, as any tallies arriving via the 
router associations. 
 
If the UMD is router / matrix associated and there are tallies associated with the router these 
Direct Tallies do not need to be set. 
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A Direct Tally may be assigned from any of the sources (that has a valid tally set to it – see 
the Tally Section) shown in the drop down box.   
 
Tallies from a parallel I/O may be mapped directly to the UMD.  These tallies will be flagged 
as Program or Iso 1 – 15, so as long as the Display Tally Mask is set to accept that Tally 
Channel, the UMD’s LED will light.  Please see section 4.6. 
 
If the UMD is a router-associated UMD, tallies may be derived from tallies router destinations 
or sources, as appropriate.  If it is wished that only Direct Tallies act on the UMD,  the 
Exclusive box must be checked. 
 
8.0 Display Colour and  Tally Assignments 
 
There are two ways for controlling the tally and display colour. 
 
Tally Bits and Configure Display menus. 
 
The Tally Bits menu is described first as an understanding of the method of mapping tallies to 
the display is essential. 
 
Tally Bits – Basic  (L-R) 
 
 

 
 
 
Tally Channel 
 
The left Tally LED needs to be associated with the required Tally Channel.  Tallies active in 
the Tally Channel will light the UMD LED.  
 
Click on the Left Mask button 
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This shows that the left UMD LED will accept the following Tally Channel – Program/Red 
Tallies.  
 
The Right Tally LED needs to be set. 
 
Click on the Right Mask button. 
 

 
 
This shows that the right LED will accept the following Tally Channel – Program/Red Tallies.  
 
Both the left and right UMD tally LEDs will be lit. 
 
If Iso 1 was check instead, the Direct Tally would not light the UMD LED as, in this case, the 
Direct Tally does not belong to the Tally Channel.  However, if the UMD is, say, router 
associated, and there are active tallies in the system with the identifying flag as Iso 1, in this 
case the UMD tally LED would be lit. 
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Example 1 
 

 
 
 
This screen shows that a Tally In is assigned from the Parallel Interface and Tally 1 which has 
the name Cam1 – Red, has been assigned to the UMD. 
 
Tally 1 (Cam1 – Red), belongs to the first of the 16 channels (default name Program, but 
renamed here to Program/Red Tallies) and will light both the LH and RH tally lamps on the 
UMD.  It will be seen that the UMD’s Left Tally Channel Mask is set to accept the first tally 
channel – Program/Red Tallies. 
 

 
 
The UMD Mask settings.  The settings for the Right Mask are the same. 
 

 

A double-click on the 
Left or Right Mask 
will show this box. 

Tally 1 derived from 
the Parallel Interface 
is set to Tally 
Channel 1: 
Program/Red Tallies 
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Example 2 
 
A System Tally may consist of two input tallies, (with the Active Tally Out Channels set to, 
say, Iso 1 and Iso 2) from a Parallel I/O using separate Tally Channels, also flagged as Iso 1 
and Iso 2.  This System Tally may be assigned to the UMD and the Left and Right Masks set 
to accept the desired active tally channel, Iso 1 or Iso 2.  This will give individual control of the 
left and right tally LEDs. 
 
The tally ins are set to belong to specific Tally Channels. 
 

  
 

 
 

 

System Tally 1 
is made up of 
two I/P tallies, 
Tally 2 and 
Tally 3, 
assigned to 
Tally Channels 
Iso 2 and Iso 3. 
 
The Active 
Tally Channel 
Mask is set to 
allow these 
tallies through 

System Tally 1 
is assigned to 
the UMD but 
the Mask has 
been set to 
accept Iso2 for 
the Left Tally 
and Iso3 for the 
Right Tally. 
 
Separate left 
and right 
tallying is now 
possible via a 
System Tally. 
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Tally Channel Masks 
 

  
 
As the left and right masks are set for Iso1 and Iso2, separate tallying of the LEDs is possible 
via a System Tally.
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Tally Bits – Extended 
 
Note:  Multiviewers should be used with the Basic settings. 
 
This is where the UMD tally/text colours are controlled. 
 
It will be seen that the Left Tally LED, the Text and the Right Tally LED are treated slightly 
differently. 
 

  
 
Display Tally - Left 
 
A mouse click on the Red Mask will show the following dialog box: 
 

 
 
Select the Tally Channel that is to light the Left UMD tally LED Red 
 

. 
 

The dot shows 
which Tally 
Channel has 
been set to the 
Mask 
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Select the Tally Channel that is to light the Left UMD tally LED Green, if required. 
 
With an active Tally Channel set to both the Red and Green Masks the LED will light 
Amber/Yellow. 
 
Display Tally - Right 
 
This is set in the same manner as the Left Display Tally. 
 

  
 
 
 

 
 
 
 
 
 
 
 
 
 
 



 

V2.5 21 UMD 

Text – Colour 
 

  
 
 
A click on the Red Mask will show the following dialogue box. 
 

 
 
Checking an Active Tally Channel will allow any tally assigned or flagged as belonging to that 
channel, to turn the text Red.  
 
It will be seen that once the default text colour has been set, the mask colour options will 
change to allow the incoming selected Tally Channel to make a change to the text colour.  
 

  

Default Text 
Colour is 
selected here. 

Using Red as 
the text default, 
the mask 
options change 
to Green and 
Yellow. 
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Note.  When a TSL UMD has been used in the Extended mode, it will need to be de-powered 
and re-powered to read the Basic tally mode. 
 
Auxiliary 
 
For future use. 
 
Note for Static Displays – S8Cs. 
 
The Extended menu will be slightly different but the principles are exactly the same as for the 
dynamic displays. 
 

Using Yellow 
as the text 
default, the 
mask options 
change to Red 
and Green. 
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Configure Display Menu 
 
This menu is a somewhat simpler option of setting the behaviour of the dynamic displays than 
using the Tally Bits menus.   
 
Greater control of colour is offered by using the Tally Bits menu. 
 
 
 
 

 
 
 

 
 
 
Set the boxes as required. 
 
If the Extended option is subsequently selected in the Tally Bits menu the UMD may need to 
be re-powered to accept the changes. 
 

Configure 
Display 
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9.0 Editing Shortcuts 
 
UMD Brightness and Justification may be done on a global basis by using Edit Group. This 
achieved by marking the list and using the RH mouse button. 
 
Sequential UMD editing may also be carried out by using Edit Selection. This achieved by 
marking the list and using the RH mouse button. 
 
Note 
 
Edit Selection will allow a UMD by UMD edit box to be displayed to allow all parameters to 
be edited whilst Edit Group will allow only the main attributes to be edited such as 
justification and brightness. 
 
 
 

  
 
 

Use Ctrl or Shift 
and the Mouse 
as required to 
select the 
UMDs. 
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Edit Selection 
 
Holding down Ctrl + a mouse click will allow a selection to be made in the normal Windows 
manner. 
 
A RH mouse click will then allow Selection Editing. 
 

 
 
 

 
 
Editing is carried out on a UMD by UMD basis. 
 

Editing of only 
the main 
common 
parameters of 
all the UMDs in 
the list is 
possible. 
 
Brightness 
Justify 
Tally Bits 
Configure 
Display 
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Edit Group. 
 
Holding down Ctrl + a mouse click will allow a selection to be made in the normal Windows 
manner. 
 
A RH mouse click will then allow Group Editing. 
 
 

  
 
 
10.0 Copy and Pasting Names and Mnemonics into the Lists. 
 
Names and Mnemonics may be cut and pasted between lists in TallyMan and Excel for easy 
updating and editing. 
 
Use Edit > Copy Mnemonics or Edit > Copy Names and Edit > Paste Mnemonic or Edit > 
Paste Names as appropriate. 
 
 

 
 

Editing of only 
the main 
common 
parameters of 
all the UMDs in 
the list is 
possible. 
 
Brightness 
Justify 
Tally Bits 
Configure 
Display 
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10.1 Using other programs to edit / copy the UMD Names and Mnemonics lists. 
 
If the UMD Names or Mnemonics are selected and copied (RH mouse button or via Edit > 
Copy Mnemonics or Edit > Copy Names) the text may be downloaded into other 
applications such as Microsoft Excel.  
 
No delimiters should be checked for vertical filling in Excel.  Various delimiters are available 
for loading into other programs. 
 
Open Excel and mark the first box.  Click on Paste and the Names or Mnemonics will be 
entered. 
 
Lists may be created in other programs, such as Microsoft Excel and pasted into TallyMan. 
 
Mark the list and copy to the Clipboard.  Open TallyMan and paste into the Names or 
Mnemonics lists as required. 
 
 
11.0 Multiviewers 

Multiviewers are treated in a very similar manner to TSL displays. 

They by be driven off Control 4 on a TM1/2 as long as Basic tally mapping is used or a 
Multiviewer module may be entered. 
 
 

 
 
 
For Multiviewers select UDP if IP connections are available. For UDP connections the number 
of UMD addresses available is 126 per IP/PORT combination. So, any single IP address can 
have as many drivers as necessary 
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Adding displays/PIPs. 
 

 
 
 
Using a RH mouse button it will be possible to auto arrange the PIPs within the frame.   
Due to the program operation it is not possible to use Ctrl to copy the Multiviewer screens 
across the desktop. 
 
Shift and LH mouse click will delete the PIP. 
 
Using Source Manager. 
 

 
 
Dragging the source to the PIP will make the PIP a Fixed Router Source display.   
 
If the PIP is assigned to a Matrix Destination it will show the source mnemonic that the actual 
destination selects. 
 
However, if a Source from Source Manager is selected and Shift is held down, the actual 
router will be controlled instead to the PIP changing to a Fixed Router Source Display. 
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